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Notice

While reasonable efforts were made to ensure that the information in this document was complete and accurate at the time of
printing, Avaya Inc. can assume no liability for any errors. Changes and corrections to the information in this document may be
incorporated in future releases.

Documentation Disclaimer
Avaya Inc. is not responsible for any modifications, additions, or deletions to the original published version of this
documentation unless such modifications, additions, or deletions were performed by Avaya.

Link Disclaimer

Avaya Inc. is not responsible for the contents or reliability of any linked Web sites referenced elsewhere within this
Documentation, and Avaya does not necessarily endorse the products, services, or information described or offered within
them. We cannot guarantee that these links will work all of the time and we have no control over the availability of the linked
pages.

License

USE OR INSTALLATION OF THE PRODUCT INDICATES THE END USER’S ACCEPTANCE OF THE TERMS SET FORTH
HEREIN AND THE GENERAL LICENSE TERMS AVAILABLE ON THE AVAYA WEBSITE AT
http://support.avaya.com/Licenselnfo/ (“GENERAL LICENSE TERMS”). IF YOU DO NOT WISH TO BE BOUND BY THESE
TERMS, YOU MUST RETURN THE PRODUCT(S) TO THE POINT OF PURCHASE WITHIN TEN (10) DAYS OF DELIVERY
FOR A REFUND OR CREDIT.

Avaya grants End User a license within the scope of the license types described below. The applicable number of licenses and
units of capacity for which the license is granted will be one (1), unless a different number of licenses or units of capacity is
specified in the Documentation or other materials available to End User. “Designated Processor’” means a single stand-alone
computing device. “Server” means a Designated Processor that hosts a software application to be accessed by multiple users.
“Software” means the computer programs in object code, originally licensed by Avaya and ultimately utilized by End User,
whether as stand-alone Products or pre-installed on Hardware. “Hardware” means the standard hardware Products, originally
sold by Avaya and ultimately utilized by End User.

License Type(s): Designated System(s) License (DS).

End User may install and use each copy of the Software on only one Designated Processor, unless a different number of
Designated Processors is indicated in the Documentation or other materials available to End User. Avaya may require the
Designated Processor(s) to be identified by type, serial number, feature key, location or other specific designation, or to be
provided by End User to Avaya through electronic means established by Avaya specifically for this purpose.

Copyright

Except where expressly stated otherwise, the Product is protected by copyright and other laws respecting proprietary rights.
Unauthorized reproduction, transfer, and or use can be a criminal, as well as a civil, offense under the applicable law.

Third-Party Components

Certain software programs or portions thereof included in the Product may contain software distributed under third party
agreements (“Third Party Components”), which may contain terms that expand or limit rights to use certain portions of the
Product (“Third Party Terms”). Information identifying Third Party Components and the Third Party Terms that apply to them is
available on Avaya’'s web site at: http://support.avaya.com/ThirdPartyLicense/

Avaya Fraud Intervention

If you suspect that you are being victimized by toll fraud and you need technical assistance or support, call Technical Service
Center Toll Fraud Intervention Hotline at +1-800-643-2353 for the United States and Canada. Suspected security
vulnerabilities with Avaya Products should be reported to Avaya by sending mail to: securityalerts@avaya.com.

For additional support telephone numbers, see the Avaya Support web site (http://www.avaya.com/support).

Trademarks

Avaya and the Avaya logo are registered trademarks of Avaya Inc. in the United States of America and other jurisdictions.
Unless otherwise provided in this document, marks identified by “®,” “™” and “SM” are registered marks, trademarks and
service marks, respectively, of Avaya Inc. All other trademarks are the property of their respective owners.

Documentation information
For the most current versions of documentation, go to the Avaya Support web site (http://www.avaya.com/support) or the IP
Office Knowledge Base (http://marketingtools.avaya.com/knowledgebase/).

Avaya Support

Avaya provides a telephone number for you to use to report problems or to ask questions about your contact center. The
support telephone number is 1 800 628 2888 in the United States. For additional support telephone numbers, see the Avaya
Web site: http://www.avaya.com/support.
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Phone Manager:

1. Phone Manager

This guide covers the installation, configuration and administration support for IP Office Phone Manager. Phone Manager
software is a single application that can be run in several modes:

e Phone Manager Lite
No license required.

¢ Phone Manager Pro
A Phone Manager Pro license key is required for each Phone Manager Pro user. If insufficient licenses are available,
Phone Manager operates in Lite mode.

¢ Agent Mode
This mode is a selectable option, available to users configured for Phone Manager Pro. In this mode, the
Phone Manager user has access to several call center agent related functions.

e Login Mode (Hot Desking)
This mode is a selectable option available to users configured for Phone Manager Pro. Starting or stopping
Phone Manager can be used to log the user on or off a physical extension. The extension is specified when
starting Phone Manager. When logged on, the Phone Manager user's own extension number overrides that of
the any user currently logged onto that extension.

e Telecommuter Mode (Phone Manager 4.1+)
In this mode, a user running Phone Manager Pro on a PC with a data connection to the IP Office (for example
via VPN), is able to have their calls routed to a telephone number they specify when starting Phone Manager.
When the user makes a call using Phone Manager, the IP Office will call the user's specified telephone number
and when answered, then make the outgoing call for the user. Similarly incoming calls to the user's extension
on the IP Office are routed to the remote number. By having the speech part of all calls initiated from the IP
Office, the cost for those calls is assigned to the IP Office.

e Phone Manager Pro PC Softphone
Each Phone Manager Pro PC Softphone (VolP) mode user requires a '‘Phone Manager Pro' and a 'Phone Manager
Pro IP Audio Enabled' license key. If insufficient licenses are available, Phone Manager operates in Lite mode.

The modes available are controlled by the Phone Manager licenses entered into the IP Office configuration. The mode for
each user is set through the IP Office Manager program.
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1.1 Installation Summary

The installation process is divided into the following steps. These should be performed in the order indicated.
1. O System-Wide Actions
The following steps should be completed before installing Phone Manager on any individual PC.

1.1.0 Pre-Installation Requirements/ 9%
Check that the pre-installation requirements for material required and PC specifications have been meet.

1.2.0 Planning forms[ 1™
Ensure the planning forms or a similar document has been completed.

1.3.0 Entering License Keys/| 1
If any Phone Manager Pro and or Phone Manager PC Softphone users are being installed, the appropriate
licenses must be installed (along with the IP Office Feature Key dongle if necessary) and checked.

1.4.0 User Configuration[ 14
Various aspects of Phone Manager operation including the mode in which Phone Manager runs are set through
the IP Office system configuration.

2. 0O Individual PC Actions
Once the above steps have been completed, installation onto individual PC's can be commenced.

2.1.0 Remove previous versions of the software[25Y
Versions of Phone Manager prior to Phone Manager 3.2 do not support upgrading. These versions must be
removed before proceeding with the installation of Phone Manager 3.2 or higher.

2.2.0 Install the Phone Manager software| 163
The process assumes that the user's PC is connected to the LAN and can see the IP Office. For more information,
see Installing Phone Manager Software[ 164,
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Phone Manager: Installation Summary

1.2 Pre-Installation Requirements

O Materials Required

¢ [ Phone Manager Software
The Phone Manager software is provided either on:

e [0 The IP Office User Application CD.
e [0 The IP Office Applications DVD.

e [ Alternately the software can be downloaded from http://support.avaya.com.

e O AvayaFW.bat
This file is a batch file that adds various IP Office applications and the ports that they frequently use as exceptions to
the Windows in-built firewall settings. This file can be downloaded from http://marketingtools.avaya.com/tools/
firewall.

e [ Licenses
Phone Manager Lite does not require any licenses. Phone Manager Pro and Phone Manager PC Softphone require the
following licenses entered into the IP Office system configuration. The licenses must match the serial number of the
Feature Key dongle present in the IP Office system.

e [0 Phone Manager Pro (per user)
Enables Phone Manager Pro for 1, 5, 10, 20, 50, 100 or unlimited users.

e [0 Phone Manager Pro IP Audio Enabled (per seat)
Enables Phone Manager Pro IP Softphone operation for a user. The user also requires a Phone Manager Pro license.

O Information Required
This information can be gathered by completing the Planning Forms included in this documentation. The following
minimum information is required.

e [ Details of the user names, extension numbers and the required Phone Manager types are required.
e [ Also PC locations and account name and password necessary for PC Administrator rights during installation.

e [ Service user name and password for IP Office system configuration access.
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O User PC Requirements
There are the minimum recommended PC specifications for Phone Manager.

Pentium |Celeron |AMD XP Vista 2000 2000 2003
Pro Pro Server Server

Lite/Pro  |64MB 160MB  [800MHz |Celeron 3 |Althon B x x
800MHz |650Mhz

PC 128MB  [1GB o X x x x

Softphone

e [0 Language Support
Phone Manager supports the following languages. The language used can be selected by the user when running Phone
Manager.

e Brazilian, Chinese (Simplified), Danish, Dutch, English, Finnish, French, German, Italian, Korean, Latin Spanish,
Norwegian, Portuguese, Russian, Spanish and Swedish.

e Additional Requirements
e [ MS Internet Explorer 6.0 or higher.
e [ A sound card is needed if audio features are required.

e [0 Phone Manager Pro PC Softphone also requires the user's PC to have a speaker and microphone installed. The
user must be associated with an IP extension on the IP Office.

e [ If installing Phone Manager Pro PC Softphone, it is recommended that QoS is setup. For more information, see
VoIP Quality of Service (QoS)! 26",

e [ VolP operation of Phone Manager is subject to the same requirements of VolP network assessment as for any
other IP Hardphone installations.

e [ For remote PC VolP operation, only VPN connections are supported. Non-VPN connections might work but are not
supported.

e [0 Phone Manager is only supported on the primary screen of dual and multi-screen PC configurations.
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Phone Manager: Pre-Installation Requirements

1.3 Planning Forms

Completing the following details will assist in the installation of Phone Manager at a site.

. Site Name:

. Customer Contact Name:

e Contact Telephone Number:

. IP Office System:
. IP Address: : : :
. Sub-Net Mask: :

e Feature Key Dongle:
Required if any users are to use Phone Manager Pro or Phone Manager PC Softphone modes.
e [1 Already installed / 0 Being installed at same time.
e Dongle Type: O Serial / O Parallel / O USB.

e Dongle Serial Number:

e Feature Key Server PC:
(Required for parallel or USB port feature key dongle).

e IP Address: M
e Sub-Net Mask: :

. License Keys:
It is recommended that the Phone Manager license keys, if used, are obtained in the form of an electronic document
from which they can be cut and pasted. This reduces the chance of errors during license key entry.
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Phone Manager Users

Real Name Extension Number |Password Location
O

Phone Manager Type

O O

O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
O O O
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Phone Manager: Planning Forms

1.4 Entering License Keys

This section assumes that the IP Office feature Key dongle has already been installed and setup plus the IP Office Feature
Key server software if required. If this is not the case, refer to the IP Office Installation manual.

To enter license keys in IP Office Manager:

1.Make sure that you have the list of licenses ready and that they match the serial number of the dongle being used
by the IP Office.

2.Preferably the licenses should be in an electronic document from which they can be cut and pasted into the
configuration. This reduces the chances of errors in the license entry.

3.0pen IP Office Manager. Click -?l-- and receive the configuration from the IP Office system.
4.Click ¥ License. Any existing licenses are listed.

5.Click Create a New Record in the Group Pane. Select License.

= R W

License

6.Enter the license key in the license key field. If the licenses are in an electronic format copy the license and paste
in the license key field.

7.Click OK. The Status of the newly entered license is Unknown.

8.Repeat the above steps for any additional licenses.

9.Click L'E‘ and send the configuration back to the IP Office. If the only changes made were to add license keys, this
can be done using merge.

10.Click -?l-- and receive the configuration from the IP Office system again.
11.Click %= License.

12.Verify that the Status of the license entered has changed to Valid. If a license is listed as Invalid, ensure that it
was entered correctly.

Checking Licenses using Phone Manager
The number of licenses available and the number still free can be checked through any running copy of Phone Manager.

1.Select Help > About Phone Manager.

2.Hold down the Ctrl and Shift keys. A list of licenses is shown.
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1.5 Changing IP Office Manager

Within the IP Office configuration, a number of user settings for Phone Manager are located on the User | Phone
Manager Options tab. These settings can be applied in a number of ways.

e They can be applied to the user the first time they start Phone Manager on a PC but then changed by the user.
e They can be applied to the user every time they start Phone Manager.

e They can be set as part of a set of User Rights which are then associated with the users to which they should be
applied. This method allows the same settings to be applied to a large number of users and then be altered as required
through the User Rights rather than having to alter each individual user.

Important

1.The key setting that must be completed is the Phone Manager Type. By default this is set to Lite for Phone Manager
Lite operation.

2.User's intended for Phone Manager PC Softphone must be associated with a non-physical VolP extension within the IP
Office configuration, that is not with a physical VolP phone extension.

IP Office Manager Configuration Settings

1.0pen IP Office Manager. Click -?l-- and receive the configuration from the IP Office system.

2.Click ﬂ and click the user's extension number in the Navigation Pane.

3.Select the Phone Manager Options tab. Those options marked with a 2 icon can also be set as part of the User
Rights.

e Allow user to modify Phone Manager settings: Default = On

This setting is used with the Phone Manager Status Options, Screen Pop Options and Hide Options below.

It controls whether those options are applied every time the user starts Phone Manager or only the first time the

user starts Phone Manager.

. If this setting is enabled, then the IP Office configuration setting of those options are only applied the first
time a user starts Phone Manager on a PC. Those settings become part of the user's Phone Manager profile
on that PC. They can be changed by the user through Phone Manager. On subsequent Phone Manager starts
the Manager settings are ignored.

. If this setting is not enabled, the IP Office configuration settings are applied every time the user starts
Phone Manager and cannot be overridden by the user.

e Agent Mode: Default = Off 2/
This option controls the setting of the Agent Mode option on the Configure Preferences | Agent Mode tab
within Phone Manager Pro. When enabled, the user has additional toolbar controls for Busy Wrap Up, Busy
Not Available and Select Group. Note that the options on the Phone Manager Pro Agent Mode tab can be
greyed out from user changes by the Agent Mode setting in Configuration Options below.

. Phone Manager Type: Default = Lite
Determines the mode in which the user's copy of the Phone Manager application operates. Modes are Lite, Pro
and Phone Manager PC Softphone. Note that the number of users able to simultaneously use Pro and VolP
modes is controlled by licenses entered into the IP Office configuration. This setting cannot be changed by the
user. * For pre-3.2 IP Office systems this setting is located on the User | User tab.

e VoIP Mode: Default = On
This option only appears if the selected Phone Manager Type is Phone Manager PC Softphone. It sets
the Enable VolIP control within the user's Phone Manager PC Softphone.

e Book a Conference in Phone Manager: Default = Off
When enabled, displays links in the user's Phone Manager application for access to the IP Office Conferencing
Center application if installed. Note that to book a conference requires the user to have a Conferencing Center
user ID and password. This feature also requires the Conference Center URL to be set (System | System).
This setting cannot be changed by the user. * For pre-3.2 IP Office systems this setting is located on the User |
User tab.

. Configuration Options J
These options allow the user access to the indicated configure preferences tabs within Phone Manager.

e The controllable tabs for Phone Manager Lite are Telephone and Do Not Disturb.

e The additional controllable tabs for Phone Manager Pro and Phone Manager PC Softphone are Screen Pop,
Compact Mode, Agent Mode, Voicemail (Voicemail and Voicemail Ringback controls only) and in IP
Office 4.0 and higher Mobile Twinning.
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Phone Manager: Changing IP Office Manager

. Screen Pop Options 2
These options allow selection of the Phone Manager Pro/Phone Manager PC Softphone screen pop options
Ringing, Answering, Internal, External and Outlook.

e The Allow user to modify Phone Manager settings option controls whether these settings are applied
only when Phone Manager is first started or every time Phone Manager is started.

e Phone Manager Status Options 2
These options allow selection of the tabs to show within the call history area of the user's Phone Manager.

e The tabs selectable for Phone Manager are All, Missed, Status and Messages.

e The additional tabs selectable for Phone Manager Pro and PC Softphone are Incoming, Outgoing and
Account Codes.

e The Allow user to modify Phone Manager settings option controls whether these settings are applied
only when Phone Manager is first started or every time Phone Manager is started.

. Hide Options J
These options allow selection of the Phone Manager Pro/Phone Manager PC Softphone options Hide on close
and Hide on no calls.

e The Allow user to modify Phone Manager settings option controls whether these settings are applied
only when Phone Manager is first started or every time Phone Manager is started.

4.Select the Telephony tab. Check the following options:

e Call Waiting On.
When Call Waiting is on there is an audible tone when you are on a call and another call arrives. Phone Manager
allows the user to see the details of both calls and to switch between calls and is therefore a useful feature for
users with analog extensions. This option is ignored for users logged on to phones with multiple call appearances.

e Busy On Held
When a call is placed on hold, it might be inconvenient to receive any further calls. For analog extension users it is
recommended that Busy on Held is switched on. A busy tone is heard by further callers until the held caller is
cleared. This option is ignored for users logged on to phones with multiple call appearances.

¢ Offhook Station.
Off Hook operation allows actions in Phone Manager, such as answer or make a call to be mirrored by the handset
hook switch of the users telephone. Depending on the phones hands free capabilities this allows the user to
answer, end and make calls using Phone Manager. This is not supported for analog extensions.

5.Click OK.

6.Repeat for any other users.

7.1f all IP Office configuration changes are complete, click L'E‘ and send the configuration back to the IP Office.
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1.6 Installing Phone Manager Software

This process assumes that the user's PC is connected to the LAN and able to see the IP Office.
To install Phone Manager:
1.Ensure that you have:
e |IP Office user name and password.
e Phone Manager software or path to Phone Manager software on the network.
e AvayaFW.bat file or path to that file on the network.
2.Log on using an account with administrator rights for the PC, that is sufficient rights to install applications.
3.Check whether Phone Manager is already installed or not. If already installed:

e If the version is pre-Phone Manager version 3.2, it must be removed before proceeding any further. See Removing
Old Phone Manager Software| 25,

o If the version is Phone Manager 3.2 or higher, it can be upgraded. See Upgrade Procedurel 253,

4. Inserts the media containing the Phone Manager Software or browse to the network location where the software has
been placed.

e If installing from the IP Office User Applications CD, the CD should auto-start. If not open the CD and double click
on setup.exe.

5.The Setup Language window appears.

IP Dffice User Suite - InstallShield Wizard

Choosze Setup Language

Select the language faor the installation from the choices below.

Chineze [Simplified]
Chinese [Traditional]
Danizh

Diutch

Finnizh

French [Standard]
German

[talian

Japanesze

K.orean

M aonwegian
Faortugueze [Brazilian]
Portuguese [Standard]

Rizzian =

Hest > ][ Cancel
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Phone Manager: Installing Phone Manager Software

6.Sele

ct the languag

e for the installation and click Next. The Preparing Setup screen appears for a moment.

IP Office User Suite - InstaliShield Wizard Wli=l3
Preparing Setup .

%
Pleaze wait while the |nstallShield ‘\Wizard prepares the setup. = "

IP Office Uszer Suite Setup iz preparing the [nstallShield YWizard, which will guide vou through the
rezt af the setup process. Flease wait,

TTT] J

Cancel

7.The Welcome to the InstallShield Wizard for IP Office User Suite window appears.

IP Dffice User, Suite - InstallShield Wizard E|

Welcome to the InstallShield Wizard for IP
Office User Suite

The InztallShigld® ‘wizard will ingtall IP Office User Suite
on your computer. To continue, click Mest,

< Back uexb J[ Cancel

8.Click Next.

Phone Manager
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9.The Customer Information window appears.
IP Office User Suite - InstallShield Wizard

Customer Information

Fleaze enter your information.

Uzer Mame:

|Mark |

Company Mame;

iy |

Inztall this application for:

(%) Arwone who uses this computer [all users)

) Orly for me [Mark]

¢ Back " Hext » ][ Cancel

10.Type the user and customer name.
11.Select Anyone who uses the computer and click Next.
12.The Choose Destination Location window appears.

IP Office User Suite - InstallShield Wizard

Choose Destination Location
Select folder where zetup will inztall files.

Setup will install IP Office User Suite in the following folder.

Toinstall ta this folder, click Mest. Tainstall to a different folder, click Browse and select
anather folder.

D eztination Falder

C:\Program Filez\AyvapatlP Office

< Back ]MEHH |[ Cancel ]

13.Leave the directory setting at default unless absolutely necessary. Click Next.

Phone Manager
IP Office
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Phone Manager: Installing Phone Manager Software

14.The Setup Type window opens.

IP Dffice User Suite - InstallShield Wizard
Setup Type

Select the setup type that best suitz your needs.

Uzer Suite - Chck the twpe of setup wou prefer.

Drezcription
ED”:F'ECt Pragram will be installed with the
Wl i e R o
YOICa

Manager with all Languages and
TAFI]. Recommended for most
LiZErs,

Spaceon C:
Required: A0ME

Ayailable: 1044571 MB

¢ Back " Hest » ][ Cancel

15.Select either Compact or Typical.

¢ Compact installs just Phone Manager and the language files that best match the PC.

e Typical installs Phone Manager and all supported languages plus the IP Office TAPI software.
16.Click Next.

17.The Start Copying Files window opens. To review or change any settings, click Back.
IP. Office User Suite - InstallShield Wizard
Start Copying Files

Feview settings before copying files.

Setup haz enough infarmation to start copping the program files. 1F you want bo review or
change any settingz. click Back. [f vou are satisfied with the settings, click Mest to begin

copring files.
Current Settings:
IP Office Uzer Suite will be installed in following location: s

C:\Program Files'Avapahl P Office A
'ou have zelected following zetup type: L

Twpiczal
Faollowing features will be inztalled:
FPhone Manager
Lanquages
Chinese v

< Back ]MEHH J[ Cancel

18.To begin copying the files, click Next.

Phone Manager
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19.The Setup Status window appears. The files may take a few minutes to install.

IP Dffice User Suite - InstallShield Wizard

Setup Status

The InstallS hield *izard is installing 1P Office User Suite

Installirg

C:h. MB3BEDAFT-01EZ-4746-B474-90B1 D1 E70A2B datal .cab

(TTITITE
20_.When copy if files is complete the InstallShield Wizard Complete window appears.

IP Office User Suite - InstallShield Wizard

InstallShield Wizard Complete

The InstallShield Wizard haz successtully installed |P Office
Ilzer Suite. Before you can uze the program, pou rmuszt restart
aur cormputer.

(3 %es, | want to restart my computer now.

(%3, | will restart my computer later.

Remove any dizks from their drives, and then click Finish to
complete setup.

21.1f TAPI was installed, the PC may request a restart. Do not agree to this at this stage.

22.Click Finish.

23.Run the file AvayaFW.bat. This adds the IP Office applications on the user's PC as exceptions to the Windows default
firewall. Do this even if the user is not using the Windows default firewall. If the users has different firewall software
installed on their PC then different actions may be required to ensure the necessary exceptions are added to that
firewall software. See Phone Manager Ports and Firewalls| 24,

24 Restart the PC and log on with the intended users account.

25.Phone Manager should automatically start. Enter the users name and password as set on the IP Office system. If the
user is the only user of the PC, enable the Remember password option.
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Phone Manager: Installing Phone Manager Software

26.0nce Phone Manager has started, check that Phone Manager is running in the Lite or Pro mode as required. If so, the
main installation process has been completed.

e For Phone Manager PC Softphone user an number of additional configuration steps need to be completed. See
Configuring a PC Softphone| 224,
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1.7 Configuring a PC Softphone

The presence of the ;';ﬂ and k4 icons indicate that Phone Manager is running in VolP mode. The title bar should also
state Phone Manager iPro or Phone Manager SoftPhone.

Requirements and Notes
Phone Manager software checks for all the following when started. If not enabled, the application will not start in Phone
Manager PC Softphone mode.

e There must be valid Phone Manager Pro and Phone Manager Pro IP Audio Enabled licenses available when
the user starts Phone Manager.

e The user must be associated with an non-physical VolP extension in the IP Office configuration. That is not with
a physical VolP extension.

e The user's Phone Manager Type in the IP Office configuration (User | Phone Manager Options) must be set
to Phone Manager PC Softphone and the option PC Softphone mode should be enabled.

e The PC must be enabled for audio playback and recording via an installed soundcard or USB microphone
headset.

e Phone Manager PC Softphone always uses the default device specified under the Multimedia tab in the
Windows control panel.

e Ensure that Use only preferred devices tick box is enabled in the Audio tab of the Sounds and Audio
Devices option in the Windows control panel.

To make the changes in Phone Manager:

1.Click > Phone Manager. Alternatively, click View > Preferences > Phone Manager. The Phone Manager
window opens.

) Pop Phone Manager & Showe &l
) Hide: on Close &) Showe In
& Play Sounds &) Showe Ot
) Hide on no Calls &) Show Mizzed
() Pop on Answwer ) Show Messages
& Pop on Page Call & Showe Status
& Enable YalP @ Showe Cost of Call
&) Showe Account codes

2.Check Play Sounds and Enable VolP.

3.To save your changes, click OK.

4. Click | Audio Codec or click View | Preferences | Audio Codec. The Audio Codec window opens. Only make
changes here if they are matched by changes to the Extension | VolP settings in the IP Office configuration.

Pleaze zelect your preferred audio codec for ValP.

G WCELP
G725 BK3 MP-hLG
G171 ULAWY 64K
G ALY 64K

il

Frame Per Packet: 1 E

2 Confirm olP IP &ddress
{0 Erabile FastStart
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Phone Manager: Configuring a PC Softphone

5.Use the up and down arrows to select and adjust the list of preferred audio codec for VolP communication.

6. If you are using a low bandwidth connection for example a dial Up Modem, increasing the Frames per packet to 2
might improve the quality of the VolP communication. However, this is not guaranteed. If you are not using a low
bandwidth connection, it is recommended you use the default value of 1.

7.1f you have multiple IP connections, select Confirm VolP IP Address for the user to be prompted to select the IP
address for VolP communication.

8.Enable FastStart should only be changed to match the setting as in the user's extension VolP settings in the IP Office
configuration. Select Enable FastStart to provide the caller with a ring tone. If it is not checked, the caller does not
hear a ring tone but the call is connected faster.

9.To save the changes, click OK.

10.Close Phone Manager. When you next start Phone Manager, the options selected will be active.

Note

e QoS support from the users PC is optional but is highly recommended. Windows 2000 and Windows XP are able to
provide the user with QoS that can be configure to match the QoS settings of the IP Office. See VolP Quality of
Service (QoS)I 264,
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1.8 Phone Manager Ports and Firewalls

Phone Manager uses the following IP ports for communication with the IP Office. If a firewall is placed between the user
PC and the IP Office, traffic on these ports should be allowed.

e Port 69 on the IP Office and the Phone Manager PC- TFTP
This is used by the Phone Manager to obtain data from the IP Office such as user name lists and the switch
directory. TFTP is also used during the application log on.

e Port 50796 on the IP Office - IPO PC Partner
This port is used by Phone Manager and Soft Console applications to establish communication with the IP Office for
call signalling, configuration changes, etc.

e Port 50799 on the Phone Manager PC - IPO BLF Updates
Used by Phone Manager to receive status updates for internal speed dial icons. These are sent from the IP Office
using the 255.255.255.255 broadcast address.

¢ VoIP
Phone Manager Pro PC Softphone uses ports 1719 and 1720 for H323 Gatekeeper discover and then a range of
ports for VolP. Therefore, we can only recommend Phone Manager Pro PC Softphone operation across a firewall
when using VPN to tunnel the connection.

Using AvayaFW.bat

This file is a batch file that adds various IP Office applications and the ports that they frequently use as exceptions to the
Windows in-built firewall settings. This file can be downloaded from http://marketingtools.avaya.com/tools/
firewall.
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Phone Manager: Phone Manager Ports and Firewalls

1.9 Removing Old Phone Manager Software

If there is a version of Phone Manager below 3.2 already installed, the application must be removed before installation. If
the Phone Manager version is 3.2 or higher you can upgrade the software. For more information, see Upgrade Procedure

[254,

« % warNING
This process will remove all installed components of the IP Office User Suite. If any of the following IP Office
applications are installed, ensure that they are reinstalled from the new IP Office User Suite:

e TAPI
e DevlLink
¢ MS-CRM

e SoftConsole

To remove existing Phone Manager software:
1.Select Start > Settings > Control Panel.
.Select Add/Remove Programs.
.From the list of Currently installed programs, select IP Office User Suite.

.Click Change/Remove. The InstallShield Wizard for the software suite is started.

2

3

4

5.When the option screen opens, select Remove.

6. When the option screen opens, select Remove.

7.You are asked 'Do you want to completely remove the selected application and all of its features?'. Click Yes.
8.0nce the suite has been removed, click Finish and close Add/Remove Programs.

9

.The Phone Manager software can now be installed. For more information, see Installing Phone Manager Software

(164,

1.10 Upgrade Procedure

If the application software is 3.2 or higher you can upgrade the software. You do not have to remove the existing version
of the software.

To upgrade your applications:

1. Insert the IP Office User Suite CD. The CD will auto-start the InstallShield Wizard. The "Welcome to the
InstallShield Wizard for IP Office User Suite' window opens.

2.Click Next. The 'Upgrade Features' window opens. A list of features that can be upgraded is listed.
3.Select the options you want to upgrade and de-select the options you do not want to upgrade.

4.To upgrade, click Next. The 'Setup Status' window opens. The selected features are upgraded, which may take
several minutes.

5.The '"Update Complete’' window opens. To exit the InstallShield Wizard, click Finish.
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1.11 VolIP Quality of Service (QoS)

Phone Manager PC Softphone can support DiffServ QoS when running on Windows 2000 and Windows XP. However, it
requires QoS to be enabled within Windows. It is still dependent of QoS being supported at all switch/routing points
between the user and the IP Office.

e  The default DSCP (DiffServ Control Point) value used by Windows is 40 unless overridden. This differs from the
IP Office system default of 46.

Windows XP

The network card/interface being used must support 802.1p and the Windows QoS Scheduler must be installed. The
DSCP value might need to be changed.

To change the DSCP value:
1. Select Start > Run and enter gpedit.msc.

2. Open Local Computer Policy > Computer Configuration > Administrative Templates > Network > QoS
Packet Scheduler.

3. For the Guaranteed Service Type, enter the required DSCP value.

Windows 2000
e The network card/interface being used must support 802.1p.

e The following DWORD registry key must be added and set to O to enable DSCP marking.
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Tcpip\Parameters\DisableUserTosSetting

e To change the DSCP value to match that being used by the IP Office network, add the following DWORD registry

key set to the required value.
HKEY_CURRENT_USER\Software\Avaya\1P400\PhoneManager\DSCP
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Phone Manager: VolP Quality of Service (QoS)

1.12 Telecommuter Mode

As normal, Phone Manager is used for call control and information over a data connection to the IP Office, with the
speech part of those calls being carried on a separate parallel voice call connection. IP Office 4.1 and Phone Manager 4.1
+ support Telecommuter mode, which allows the speech connection to be a remote phone location not on the IP Office.
Use of this mode is can be assigned to users in the IP Office 4.1+ configuration by the System Administrator.

Speech
PSTHN Connedion

Telecommuter

_Els:nmmutsr
Intemal (O fiice)
When users of this mode start Phone Manager, they are asked for their location, this is either Internal or Remote.

¢ Internal is used when they are at their normal IP Office extension. In this state the extension and Phone Manager
operate in the same way as for other internal Phone Manager users.

¢ Remote is used for they are at an external location from which they have a data connection for Phone Manager to
the IP Office and a phone on which they can make and receive direct calls. They can specify the remote location
number when logging in or use a previously saved location number. The remote phone number used must be one
that can be dialed directly from the IP Office, for example not via any switch board, receptionist or auto attendant
service. The user's normal IP Office call restrictions, if any, are applied and any external dialing prefix must be
included if used on the IP Office.

Configuring a User as a Phone Manager Pro Telecommuter

e Telecommuter is an option for Phone Manager Pro users and requires an available Phone Manager Pro license in
the IP Office configuration.

e Setting a user as a telecommuter is done through the User | Phone Manager Options | Phone Manager Type
field in IP Office Manager (or User Rights | Phone Manager | Phone Manager Type if the user is associated
with a set of user rights). Select Pro Telecommuter to allow use of telecommuter mode.

e Provision of a data connection from the user's Phone Manager Pro PC to the IP Office when remote from the IP
Office network is outside the scope of this documentation. The methods will depend on the customer network and
methods of Internet connection available. The use of VPN is recommended to ensure secure connection between
the remote site and the customer network.
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Continuous Mode

A key consideration for telecommuter operation is the trunk types involved. During Phone Manager login as a remote
telecommuter, the user is able to select whether for that location they should select Continuous Mode or not.
Continuous Mode changes the behaviour of Phone Manager and must be used when trunks without reliable disconnect are
in use or suspected to be in use between the IP Office and the user location.

o Off
If Continuous Mode is not selected, the IP Office will only call the remote location number when required, that is
when making or receiving an IP Office call. For example when making a call using Phone Manager, the IP Office
will call the remote location, when answered it will make another call using the number requested in Phone
Manager. You can end the call through either Phone Manager or by replacing the handset.

¢ In this mode, it is possible for the remote location phone to make and receive non-IP Office calls. IP Office
calls can be distinguished by their indication in the Phone Manager call details display.

e Calls will not succeed if the IP Office detects that a trunk using analog loop start or analog loop start
emulation is being used.

e Pages calls are not redirected. Intercom and dial direct calls are redirected as normal calls.

e On
If Continuous Mode is selected, once you complete the Phone Manager login, the IP Office will call the remote
location number and when answered the user should leave the connection open (off-hook). This will occur as part
of either the test call if requested or after you click OK. Phone Manager is then used exclusively to make and
answer calls, with the IP Office connecting the speech path to the remote location phone handset as and when
required.

e This option should be used whenever analog loop start trunks or analog loop start emulation trunks are in use
or suspected to be in use. This may include cellular phones connected to cellular gateways on analog trunks.

o If the IP Office has a mix of trunks, it may be advisable using outgoing group ID's, short codes and ARS forms
to configure a specific dialing prefix that ensure that their call are routed via trunks that provide reliable
disconnect and so remove the need for Off Hook Station operation.
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Chapter 2.
Configuration
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2. Configuration

e Phone Manager indicates it is connected to the switch by showing the user name inside a pair of square brackets
'[ 1'. If the title bar displays 'Phone Manager' it is not connected to the switch.

e Only one instance of Phone Manager can be run at a time. When starting Phone Manager, if an existing instance of
Phone Manager is detected, the additional Phone Manager will exit silently.

e Phone Manager checks with the switch once every minute for the availability of the voicemail server. The record
and message panes are enabled or disabled accordingly. If the messages pane is unavailable, check the status of
the voicemail server.

e Do not connect 2 or more Phone Managers to the switch using the same user name, especially when Phone
Manager is operating in VolP mode. This will lead to unpredictable or incorrect operation of Phone Manager.

2.1 User Settings and Profiles

For Phone Manager 3.0 onwards, all user settings are stored in a single local profile file. The exception is local directory
numbers. The profile file name matches the user's extension number, for example 212.xml. By default, the files are
stored in My Documents\Avaya\lP 400\PhoneManager\Profiles.

This file is created when a user with that extension number first uses Phone Manager. The file is not deleted by removal
of the Phone Manager application and a separate file is created for each extension number using Phone Manager on that
PC and that particular PC log on.

Within Phone Manager, the File > Save Profile option can be used to save a copy of the profile to a different location.
You can load a profile from a different location using the option File > Load Profile. When loading a profile, the file
name must match the user's extension number.

2.2 Directory Entries

User directory entries entered through Phone Manager are saved to the file PhoneManagerDirectory.txt. This file is
stored in My Document\Avaya\IP Office\PhoneManager. The file is a CSV file in the format:

e Name - The name to display in the directory.
e Number - The telephone number.
 wavfile - The path to the wav file to associate with the directory entry.

o scriptfile - The path to the script file to associate with the directory entry. This file can be a plain text file or an
RTF format file.

You can use Phone Manager to edit the contents and to import or export directory files. A large directory can degrade the
performance of Phone Manager as excessive CLI lookups and other actions have to be performed whenever a call arrives
or is made. The recommended maximum number of directory entries is 1000.

To configure the directory in Phone Manager:
1.Click File > Directory.
2.Make the changes as required.

3.To save the changes, click Close.
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Configuration: Directory Entries

2.3 Citrix/Thin Client Phone Manager

Phone Manager has been tested with Citrix. It is supported in Phone Manager Lite and Phone Manager Pro modes but not
in Phone Manager Pro PC Softphone (VolP) mode.

Features Supported
e Phone Manager Lite and Phone Manager Pro.
e Screen popping to Outlook, Goldmine and Maximizer (not ACT!).

e Call recording and mailbox access to VoiceMail Pro.

Features Not Supported

e Phone Manager Pro Softphone (VolP) mode.
This is because of the inability to allow upstream audio on a Citrix server with Client Audio Mapping.

e Play Sound functions.
Some support is possible if the -nosoundcheck| 381 command line option is used and client computer has an audio
card correctly mapped. However, some delay in the playing of sound might be experienced.

e The 'Hide on Close' option should not be used.

Notes

e The default skin of Phone Manager can cause issues for some thin client installations. You can run Phone Manager
without a skin by creating a empty text file called skin.ini.

e A maximum of 5 Phone Manager clients are supported using Citrix.

¢ No other IP Office applications have been tested on Citrix.
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2.4 Play Sounds Option

The Play Sounds option within Phone Manager plays various sound through the user's PC multimedia setup to announce
calls ringing and waiting. This option is available for all Phone Manager types.

The following wav files are used for the Play Sounds option. They are located in the Phone Manager application folder C:
\Program Files\Avaya\IP Office\Phone Manager. The wav files can be replaced with custom recordings as long as
they are in 16 bit mono wav file format.

¢ NewcCall.wav: Ringing.
Separate files NewCall_Eng.wav and NewCall_enu.wav can be used to replace the file with either UK or US ring
tone respectively.

¢ NewcCallWwaiting.wav: Ringing.
¢ NewMessage.wav: “You have a new message” supplied in appropriate language variants.

e Ding.wav: Ding.

To turn on the Play Sounds option:

1.Click > Phone Manager. Alternatively, click View > Preferences > Phone Manager.

) Pop Phone Manager & Showe &l
) Hide: on Close &) Showe In
& Play Sounds &) Showe Ot
) Hide on no Calls &) Show Mizzed
() Pop on Answwer ) Show Messages
& Pop on Page Call & Showe Status
& Enable YalP @ Showe Cost of Call
&) Showe Account codes

2.Check Play Sounds. Incoming calls are alerted by an incoming sound.

3.To save your changes, click OK.
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Configuration: Play Sounds Option

2.5 Configuring Instant Messaging

The Instant Messaging function of Phone Manager was developed and tested against Microsoft's Live Communication
Server (LCS) 2003. It has also been run using LCS 2005.

The LCS server requires both a Microsoft LCS server license and a LCS client license for each user. In addition, it requires
each Phone Manager user to also have Windows Messenger installed and running. You can Instant Message a user
through the Speed Dial icons in the Speed Dial Call History Pane.

Requirements
1.LCS server PC requires:
¢ Microsoft LCS 2003 or 2005 with LCS Server license.
¢ Microsoft LCS Client license for each user.
2. IP Office Configuration requires:

e The users SIP URI used for instant messaging should be entered as their Voicemail Email address in IP
Office Manager. For example j.smith@acme.com would be entered as a voicemail email address in IP Office
Manager.

3.User PC requires:

¢ Windows Messenger.
This must be running and logged in at the same time as Phone Manager.

e Phone Manager.

Once these requirements are met, Phone Manager can be configured to support interaction with the Live Communication
Server.

To activate IM in Phone Manager:

1.0pen Phone Manager.

2.Click | Instant Messaging. or View | Preferences | Instant Messaging.

&) Enable Instant Messaging Suppaort

Server |MLServerEDDS@test.avaya.cnm |
IJzer name | remotedtest avaya.com |
Fratacal | TCF E"
Fazsword |........ |

&) Femember Passyvord

3.To turn instant messaging on, check Enable Instant Messaging Support.
4.1n the Server field, enter the name of the Microsoft Live Communication Server.

5.1n the user name field, enter your email account and domain as configured on the Microsoft Live Communication
Server. For example; myname@example.com.

6.1n the Protocol field, click the type of protocol you are using to connect to the Microsoft Live Communication
Server. You can choose from TCP, UDP and TLS.

7.1n the Password field, enter the password associated with your Instant Message profile.

8.For Phone Manager to remember your password, check Password. You do not have to re-enter your password if
this box is checked.

9.To save your changes, click OK.
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To configure an audible alert

Phone Manager does not give any audible alert when an instant message is received. However alerts can be configured
through the Windows Control Panel.

Click Start > Settings > Control Panel.

Select Sounds and Multimedia or Sounds and Audio.

Select the Sounds tab.

Scroll down the list of Program Events until the events for Windows Messenger are shown.

U

Configure the events as required and click OK.
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Configuration: Configuring Instant Messaging

2.6 VoIP Notes

If the audio codec is changed in Phone Manager, the application must be restarted for the change to take effect.

If the main window does not appear after a long time, this may be because Phone Manager is trying to
communicate with the VolP server and the server is not responding. Use the Windows Task Manager to terminate
the process ‘'iClaritySrv.exe' and '‘phonemanager.exe' and restart the Phone Manager.

Windows 2000.
If Phone Manager PC Softphone operation appears to be degraded when the user performs operations such as
scrolling through a large document, the priority given by the PC to the iClaritySrv.exe task should be increased.

e Open the Windows Task Manager and select the Processes tab.
e Locate the iClaritySrc.exe process.

¢ Right-click on it and select Set Priority.

e Increase the priority as required.

Phone Manager checks for the presence of a sound card and if none is installed, the speaker and the microphone
icons are disabled. To use VolP, the microphone must be selected as the recording device and not muted. On
some soundcards this is not the default and must be set manually.

The speaker and microphone mute feature is only available if the sound card supports it.
Enable faststart and Use direct media should be set for the VoIP extension.
Offhook station should be set for the user associated with this VolP extension.

Phone Manager does not allow the user to specify which audio device to use for VolP Phone Manager. It always
uses the default device specified under the multimedia tab in the control panel.

When using the VolP feature make sure the Use only preferred devices tick box in the Audio tab is selected.
The Audio tab is in the Sounds and Audio Devices option in the control panel.
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2.7 BLF Operation

This section describes the operation of BLF updates sent out by IP Office systems. There are several, separate
mechanisms for delivering BLF updates.

1.1P Office to IP Office
IP Office systems configured with SCN (Small Community Networking) enabled, exchange user state information
using SCN messaging. Each IP Office then provides that information as BLF updates to the phones and application
registered with it using the methods described below.

2.1P Office to Phones
IP Office hard-phones exchange user state information with the IP Office on which they are registered. IP phones
do this using the phone signalling messages embedded in the H.225 stream.

3.Local IP Office User Applications
Each IP Office system broadcasts BLF updates on its own subnet (or subnets if both LAN1 and LAN2 are
supported). Those messages are used by Phone Manager and SoftConsole registered with that IP Office and
running on the same subnet.

4.Remote IP Office User Applications
When a Phone Manager on a different subnet registers with an IP Office system, that IP Office will send BLF
updates directly to the PC as a Unicast message. Each IP Office only supports up to 10 such remote Phone
Manager applications, provided on a first come first served basis. That is, upon start-up only the first 10 Phone
Manager connections from a different subnet will receive BLF updates. Subsequent remote connections will operate
as normal except they will not receive BLF updates.

The diagram below shows an example scenario.

;' Site A user — Alice  192.168.42.x/24

_-"'t:w‘ite B user — Bob 192.168.52.x/24

|5. |4- ,3 SCN

-E:.;il‘f_‘. B remote user — Carol
192.168.62.%x/24

In this scenario:
1.User Alice at Site A goes off-hook. Alice's phone updates the IP Office at Site A.

2.Across the Small Community Network connection, Site A shares the information about Alice's current state with the
IP Office at Site B.

3.Bob and Carol are both users on Site B, with phones and running Phone Manager. Bob is on the same subnet as
the Site B IP Office, however Carol is on a different subnet from the Site B IP Office.

4.Bob and Carol's phones are both updated through their phone signalling with the IP Office at Site B.
5.Bob's Phone Manager sees and uses the BLF update that the IP Office at Site B broadcasts to its own subnet.

6.As Carol's Phone Manager is one of the first 10 remote Phone Manager's to register with the IP Office, the IP Office
at Site B sends a direct BLF update to it.
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Configuration: BLF Operation

2.8 Conference Resources

A conference can be created using Conferencing Center, Phone Manager or SoftConsole. Each time a conference is
created resources are used. All the applications share the same conference resources.

System features such as call intrusion, call recording and silent monitoring all use conference resources. This includes
automatic recording, if enabled. When any of these features are active, the number of slots available for conference
parties is reduced.

The number of internal users and external callers that can be involved in conferences at the same time is limited by the
conference capacity of your IP Office telephone system.

IP Office Maximum Callers Maximum Total Maximum Number of
in Any One Number of People on | Conferences on the
Conference Conference Calls System

Small Office Edition 6 24 8

1P403 64 64 21

1P406 64 64 21

1P412 64 128 42

1P500 64 64 21

o If IP Office Conferencing Center is installed, 5 resources are reserved for use by the system, for example; call
recording. The maximum number of callers in any one conference and the total number of people on conference
calls is reduced by 5. The maximum number of conferences on the system for 1P403, IP406 and IP412 is reduced
by 2.

Examples
1.1P403 and 1P406 support multiple conferences adding up to 64 callers in conferences.
e 21 x 3 way conferences.

e 1 x 10 way conference plus 11 x 3 way conferences. Free capacity for 20 more conference callers to join new
or existing conferences.

2.1P412 supports multiple conferences totaling up to 128 callers in conference with no more than 64 callers in any
one conference.

e The IP412 supports two 63 party conference banks. When a new conference is started, the bank with the
most free capacity is used for that conference. However, once a conference is started on one conference
bank, that conference cannot use any free capacity from the other conference bank.
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2.9 Command Line Options
2.9.1 Disabling Buttons

You can disable the conference calls ttt and transfer call &€ buttons, to minimize the risk of accidental conference or
transfer. This may be required in sensitive environments where conflicting parties may be held at the same time. The
functions are still available in the Functions menu.

To disable buttons:
1.Right-click on the Phone Manager shortcut and select Properties.
2.Select the Shortcut tab.
3.The Target will be similar to: ""C:\Program Files\Avaya\lP Office\Phone Manager\PhoneManager.exe"

4. After the closing quotation mark, add -disable:ConferenceButton and/or -disable:TransferButton as
required. For example: "C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe'" -disable:
ConferenceButton -disable:TransferButton

5.Click OK.

6. Test the shortcut.

2.9.2 Logging in as a Specific User

In situations where users share a PC without logging on or off to Windows, it may be more convenient to have several
shortcuts to Phone Manager. Each shortcut can be configured for a different user. This can be done by adding the user
name and password to the separate Phone Manager shortcuts rather than changing it each time through File> Login.

To create a shortcut:
1.Right-click on the Phone Manager shortcut and select Properties.
2.Select the Shortcut tab.
3.The Target will be similar to: "C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe".

4. After the closing quotation mark, add the IP Office IP Address, the User Name in quotation marks and the user
password in quotation marks. If the password is blank, add "*'. For example: "C:\Program Files\Avaya\IP
Office\Phone Manager\PhoneManager.exe" 192.168.42.1 Extn201 ""

5.Click OK.

6. Test the shortcut.

2.9.3 No Sound Check

There are some installations where, even though no Phone Manager sound features are being used, a ""Mixer Not
Detected" error appears each time Phone Manager is started. This can be suppressed using the -nosoundcheck
command line option.

To suppress error message:
1.Right-click on the Phone Manager shortcut and select Properties.
2.Select the Shortcut tab.

3.The Target will be similar to: "C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe".

After the closing quotation mark, add -nosoundcheck. For example:
"C:\Program Files\Avaya\IP Office\Phone Manager\PhoneManager.exe" -nosundcheck

4.Click OK.

5. Test the shortcut.
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3. Screen Popping

Phone Manager Pro can be set to pop an external application whenever an incoming call arrives. In addition to starting an
external application, Phone Manager Pro also passes some basic call data to that external application. The data passed is:

e Calling Party
The number of the calling party, if available.

e Called Party
Usually the number of the Phone Manager Pro extension.

e Tag
Any name or other information associated with the call. Phone Manager and SoftConsole can be used to add a tag
to a call before it is made or transferred.

e Account Code
Any account code matched against the Caller ID of the call in the IP Office configuration directory.

e Display Text
Similar to the text string shown on display phones by IP Office when calls ring.

Screen popping requires the selected application to be running with the appropriate database at the same time as Phone
Manager Pro. The screen pop action is based on calling number (ICLID) matching.

For IP Office 5.0 and higher, screen popping is only supported with Outlook 2003/2007.
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Screen Popping:

3.1 Phone Manager Configuration

Phone Manager needs to be configured so that contact details can be shown. The screen pop options are only available
when the content management packages are installed and detected by Phone Manager.

For IP Office 5.0 and higher, screen popping is only supported with Outlook 2003/2007.

To configure Phone Manager:

1.Click | Screen Pop or click View | Preferences | Screen Pop.

= = — —_— — 1

Phone Mumber Phone Mode
2 Internal () External &) Ringing D Answvering

Program Ta Pop

[ Configure... ]

Goldhline

Maximizer

External

@ Fop Outlook

2.In Phone Number select whether Phone Manager should screen pop for Internal and/or External numbers.

3.1In Phone Mode select whether Phone Manager should screen pop when calls are Ringing or only on Answering a
call.

4.Select Pop Outlook. If the incoming number matches a number in one of your contacts, that contact will pop up.
MAPI must be installed on your PC for this facility to be available. For more information, contact your system
administrator.

5.Click OK.

6.To save your changes, click OK.
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3.2 Microsoft Outlook Notes

Phone Manager disables Outlook related functions if a suitable version of Outlook 2000, 2003 or XP is not found during
installation. Outlook 2000 or higher must be installed to enable these functions. Outlook Express is not supported.

Phone Manager uses MAPI to perform a CLI match for pop outlook. If the user does not have a default profile or no
profile exist then this function will not work.

Phone Manager only screen pops against the user's personal mailbox contacts, mailbox contacts and public folder
contacts. Where duplicate entries exist that order is the order of preference.

To enable screen pop using Microsoft Outlook Notes:
1.Click Contacts > Properties > Outlook Address Book > Show this folder as an email address book.

2.Click OK.
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4. Creating Custom Skins

This section describes how to create and loada skin for use on the IP Office Phone Manager and SoftConsole applications.
However, it does not attempt to teach how to use the required Skin Development application. Nor does Avaya support
use of skins other than those installed by Avaya as part of the default application installation.

The example shown is Phone Manager with a skin called ‘Gradic' loaded.
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To load a new skin in Phone Manager

1.Click View | Load Skin.

2.Browse to the folder containing the new skin and select the skin.ini file. Phone Manager skin files are located by
default in: C:\Program Files\Avaya\IP Office\Phone Manager\Skin\

3.Click OK.

If you want to create a skin then skin development software is required. In the example, the Business Skin Form from
Almediadev (SkinBuilder.exe) was used. Trial software and a number of samples are available from www.almdev.com.

The SkinBuilder.exe application must be used to create or edit a skin. This application allows you to manipulate your
skin visually and has a built-in tester to test your skin definition.
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Creating Custom Skins:

4.1 Phone Manager Skin Objects and Controls

To create a new skin, make a copy of the Avaya skin definition folder in the skin directory (C:\Program Files\Avaya\IP
Office\Phone Manager\Skin\) and rename. Make the necessary changes required by your design. Modify the bitmaps, the
skin objects and the skin controls.

There are a number of sections in the Avaya skin definition .ini file. The following table describes the various sections in

the .ini file:

Version
Pictures
Forminfo
PopupWindow
HintWindow
SkinObjects

Version information and comments.

Bitmap files used by the skin definition.
Bitmaps for the main window.

Bitmaps for any pop up windows (menu etc).
Bitmaps for tool tip.

Windows elements pertaining to the main window; caption bar, menu bar, maximize,
minimize and close buttons.

The following SkinObjects need to be defined for the Phone Manager main window.

closebutton
maxbutton
systembutton
minbutton
mainmenubaritem
caption

menuitem

menubarsystemmenubutto
n

menubarclosebutton
menubarmaxbutton
menubarminbutton

Bitmap for the close button in the main window.

Bitmap for the maximize button in the main window.
Bitmap for the system menu button in the main window.
Bitmap for the minimize button in the main window.
Bitmap for each item in the menu bar.

Bitmap for the main window caption bar.

Bitmap for each item in the drop down menu.

Bitmap for the system menu button on the main menu bar.

Bitmap for close button on the main menu bar.
Bitmap for maximize button on the main menu bar.
Bitmap for the minimize button on the main menu bar.

The following SkinControls need to be defined in Phone Manager.

Tab
Panel
Toolbutton

Mainpanel
Button
Controlbar
Toolpanel
mainmenubar
Checkbox
Stdlabel
groupbox
edit
toolmenutrackbutton
vscrollbar
updown
trackbar

Phone Manager uses a second

Bitmaps for the tabs; In, Out, All, Missed, Messages, Speed dials, etc.
Bitmaps for the panels used in various dialogs; Make Call, Directory, Config PBX, etc.

Bitmaps for buttons in the toolbar (except for the volume control, see the toolmenutrack
button).

Bitmap for the background of the main window.
Bitmaps for push buttons in the main window.

Bitmap for the background of the toolbar area.

Bitmap for the background of each toolbar.

Bitmap for the background of the main menu bar.
Bitmaps for check boxes.

Bitmaps for labels.

Bitmaps for group boxes.

Bitmaps for edit controls.

Bitmaps for the volume control buttons on the toolbar.
Bitmaps for the vertical scroll bar used in various places.
Bitmaps for the up/down button to scroll the tabs.
Bitmaps for the volume control slider.

.ini file called dialog.in1 to define the appearance of the dialogs. The following table

describes the various sections in the .ini file:

FormInfo
Caption
Close
Button

Bitmaps for the dialog box.

Bitmaps for the dialog box caption bar.

Bitmaps for the dialog box close button.

Bitmaps for push buttons in the dialog that resides inside a panel.
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4.2 SoftConsole Skin Objects and Controls

To create a new skin, make a copy of the Avaya skin definition folder in the skin directory (C:\Program Files\Avaya\IP
Office\Phone Manager\Skin\) and rename. Make the necessary changes required by your design, modify the bitmaps, the
skin objects and the skin controls.

There are a number of sections in the Avaya skin definition .ini file. The following table describes the various sections in
the .ini file:

Version Version information and comments.

Pictures Bitmap files used by the skin definition.

FormInfo Bitmaps for the main window.

PopupWindow Bitmaps for any pop up windows (menu etc).

HintwWindow Bitmaps for tool tip.

SkinObjects Windows elements pertaining to the main window; caption bar, menu bar, maximize, minimize
and close buttons.

The following SkinObjects need to be defined for SoftConsole.

caption "Bitmap for the form's title bar.

closebutton ||Bitmaps for the Close button in the form's title bar.
minimizebutton ||Bitmaps for the Minimize button in the form's title bar.
maximizebutton ||Bitmaps for the Maximize button in the form's title bar.
mainmenubaritem ||Bitmaps for the menu items on the form's main menu.
sysmenubutton ||Bitmaps for the System Menu button in the form's title bar.
menuitem ||Bitmaps for the drop down menus of the form's main menu.

The following SkinControls need to be defined for SoftConsole.

panel Background bitmap for dialog boxes and for various panels on the main form.

button Bitmaps for standard button controls.

toolpanel Background bitmap for the Directory and Held Calls toolbars on the main form.

toolbutton Bitmaps for button controls on the Directory and Held Calls toolbars on the main form.

bigtoolpanel Background bitmap for the main tool bar on the main form.

bigtoolbutton Bitmaps for button controls on the main tool bar of the main form.

resizebutton Bitmaps for list view column headings.

mainmenubar Background bitmap for the main menu bar on the main form.

statusbar Background bitmap for the status bar controls.

statuspanel Background bitmap for panels within a status bar control.

stdlabel Attributes of label controls.

listview Bitmap for list view controls.

hscrollbar Bitmaps for horizontal scroll bar controls.

vscrollbar Bitmaps for vertical scroll bar controls.

bothhscrollbar Bitmaps for displaying vertical and horizontal scroll bar controls simultaneously.

vsplitter Bitmap for vertical splitter controls on the main form.

hsplitter Bitmap for horizontal splitter controls on the main form.

tab Bitmaps for tab sheet controls.

hupdown Bitmaps for left/right arrow controls used for navigating through tab sheets when all of the tabs
cannot be displayed)

vupdown Bitmaps for up/down arrow controls used for navigating through tab sheets when all of the tabs
cannot be displayed)

bevel Bitmap for bevel controls.

checkbox Bitmaps for check box controls.

radiobox Bitmaps for radio controls.

groupbox Bitmaps for group box controls.
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Performance figures and data quoted in this document are typical, and must be
specifically confirmed in writing by Avaya before they become applicable to any
particular order or contract. The company reserves the right to make alterations
or amendments to the detailed specifications at its discretion. The publication of
information in this document does not imply freedom from patent or other
protective rights of Avaya or others.

Intellectual property related to this product (including trademarks) and registered
to Lucent Technologies have been transferred or licensed to Avaya.

All trademarks identified by the ® or ™ are registered trademarks or trademarks,
respectively, of Avaya Inc. All other trademarks are the property of their
respective owners.

This document contains proprietary information of Avaya and is not to be
disclosed or used except in accordance with applicable agreements.

Any comments or suggestions regarding this document should be sent to
"wgctechpubs@avaya.com".

© 2010 Avaya Inc. All rights reserved.
Avaya

Unit 1, Sterling Court

15 - 21 Mundells

Welwyn Garden City

Hertfordshire

AL7 1LZ

England.

Tel: +44 (0) 1707 392200
Fax: +44 (0) 1707 376933

Web: http://marketingtools.avaya.com/knowledgebase
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